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About this guide
This guide provides setup and troubleshooting information for the HP Z Workstation series. It includes these
topics:
Guide topics
Locating HP resources on page 1
Workstation features on page 5
Setting up the workstation on page 12
Setting up, backing up, restoring, and recovering Windows 7
on page 20
Setting up, backing up, restoring, and recovering Windows 8
on page 25
Setting up, backing up, restoring, and recovering Windows 10
on page 33
Setting up and restoring Linux on page 42
Diagnostics and minor troubleshooting on page 53
Routine care on page 58

TIP:

If you do not find what you are looking for in this guide:

— Find technical details in the Maintenance and Service Guide for your workstation at http://www.hp.com/
support/workstation_manuals.
— View component installation videos at http://www.hp.com/go/sml.
— See additional information on your workstation at http://www.hp.com/go/workstations.
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Locating HP resources
This section provides information on the following resources for your HP workstation:
●

Product information

●

Product support

●

Product documentation

●

Product diagnostics

●

Product updates

Product information
Topic

Location

Technical specifications

To find the QuickSpecs for your product, go to http://www.hp.com/go/quickspecs. Click the
link for the HP Inc. QuickSpecs experience. Click Search all QuickSpecs, type your model
name in the search field, and then click Go.

Regulatory, safety, and
environmental notices

See the Regulatory, Safety and Environmental Notices for product regulatory information.
You can also refer to the regulatory label on the workstation chassis.

Accessories

For complete and current information on supported accessories and components, go to
http://www.hp.com/go/workstations.

System board

A diagram of the system board is located on the inside of the chassis. Additional
information is located in the workstation Maintenance and Service Guide on the Web at
http://www.hp.com/support/workstation_manuals/.

Serial number, Agency/
Environmental, and operating
system labels

The serial number, Agency/Environmental, and operating system labels are on the rear
panel of the workstation.

Product information
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Product support
Topic
Product support

Location
For U.S. support, go to http://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.
Here you can access the following types of support:

Warranty
information

●

Chat online with an HP technician

●

Obtain email support

●

Find support telephone numbers

●

Locate an HP service center

To locate warranty information, go to http://www.hp.com/support/warranty-lookuptool.
To locate an existing Care Pack, go to http://www.hp.com/go/lookuptool.
To extend a standard product warranty, go to http://h20565.www2.hp.com/hpsc/wc/public/home and make
your selection from the Related Links. HP Care Pack Services offer upgraded service levels to extend and
expand a standard product warranty.
You can find your HP Limited Warranty located with the user guides on your product and/or on the CD or DVD
provided in the box. In some countries or regions, HP may provide a printed warranty in the box. For countries
or regions where the warranty is not provided in printed format, you can request a copy from
http://www.hp.com/go/orderdocuments. For products purchased in Asia Pacific, you can write to HP at
POD, P.O. Box 161
Kitchener Road Post Office, Singapore 912006
Include your product name, and your name, phone number, and postal address.
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Product documentation
Topic

Location

HP user documentation, white
papers, and third-party
documentation

User documentation is located on your hard drive. On Windows 7, select Start, select HP,
and then select HP Documentation. On Windows 8, from the Start screen, select the HP
Documentation app. On Windows 10, select Start, select All Apps, select HP, and then
select HP Documentation. For the latest online documentation, go to http://www.hp.com/
support/workstation_manuals. The documentation includes this user guide and the
Maintenance and Service Guide.

Removal and replacement videos

To learn how to remove and replace workstation components, go to
http://www.hp.com/go/sml.

Product notifications

Subscriber's Choice is an HP program that allows you to sign up to receive driver and
software alerts, proactive change notifications (PCNs), the HP newsletter, customer
advisories, and more. Sign up at http://www.hp.com/go/subscriberschoice.

Technical specifications

QuickSpecs for HP Workstations include information about the operating system, power
supply, memory, CPU, and many other system components. To access the QuickSpecs, go
to http://www.hp.com/go/qs/.

Customer Advisories, Security
Bulletins, and Notices

To find advisories, bulletins, and notices:
1.

Go to http://www.hp.com/go/workstationsupport.

2.

Select the desired product.

3.

Under the Knowledge Base heading, use the scroll bar to select Advisories, Bulletins
& Notices.

Product diagnostics
Topic
Windows diagnostics tools

Location
The UEFI Diagnostics utility is preinstalled on select Windows workstations.
For additional information, see the workstation Maintenance and Service Guide at
http://www.hp.com/support/workstation_manuals.

Definitions for audible (beep) and
light codes

See the workstation Maintenance and Service Guide at http://www.hp.com/support/
workstation_manuals.

POST error codes

See the workstation Maintenance and Service Guide at http://www.hp.com/support/
workstation_manuals.

Product documentation
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Product updates
Topic
Driver and BIOS updates

Location
Go to http://www.hp.com/go/workstationsupport to find the latest drivers for the
workstation.
To determine the current workstation BIOS version on your workstation, follow these steps
during system startup:
1.

Turn on the workstation, and press Esc during startup (boot).

2.

Press F10 to enter the F10 Setup utility.

3.

Go to File > System Information. Note the BIOS version and date and compare it with
the BIOS versions at http://www.hp.com/go/workstationsupport.

In Windows 7, you can also find the BIOS version number by following these steps:
1.

Go to Start > All Programs > Accessories > System Tools > System Information.

2.

In the right pane, find the line with BIOS Version/Date.

3.

Note the BIOS version and date and compare it with the versions that appear on the
HP website.

In Windows 8, you can also find the BIOS version number by following these steps:

Operating systems
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1.

Point to or swipe from the upper-right or lower-right corner of the Start screen to
display the charms.

2.

Select Settings > Change PC Settings.

For information, go to the following locations:
●

Go to http://www.hp.com/go/quickspecs. In the left pane, select your region and then
select Workstations.

●

Windows operating systems, go to http://www.support.microsoft.com.

●

Linux operating systems, go to http://www.linux.com.
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Workstation features
For complete and current information on supported accessories and components for your workstation, go to
http://partsurfer.hp.com.
●

HP Z440 Workstation components

●

HP Z640 Workstation components

●

HP Z840 Workstation components

●

Product specifications

HP Z440 Workstation components
HP Z440 Workstation front panel components

1

Optical drive bays

5

USB 3.0 charging port (1)

2

Optical drive

6

USB 3.0 ports (3)

3

Power button

7

Audio-out (headphone)/Audio-in
(microphone) combo jack

4

Hard drive activity light

8

Audio-in (microphone) jack

HP Z440 Workstation components

5

HP Z440 Workstation rear panel components

6

1

Power supply Built-In Self-Test
(BIST) LED

8

Audio line-in jack (blue)

2

PS/2 keyboard connector (purple)

9

PCI/PCIe card slots

3

PS/2 mouse connector (green)

10

Power cord connector

4

USB 2.0 ports (2, black)

11

Universal chassis clamp opening

5

USB 3.0 ports (4, blue)

12

Padlock loop

6

AMT-enabled RJ-45 (network) jack
(orange)

13

Security slot

7

Audio line-out jack (light green)
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HP Z640 Workstation components
HP Z640 Workstation front panel components

1

Optical drive bays

5

USB 3.0 charging port (1)

2

Optical drive

6

USB 3.0 ports (3)

3

Power button

7

Audio-out (headphone)/Audio-in
(microphone) combo jack

4

Hard drive activity light

8

Audio-in (microphone) jack

HP Z640 Workstation components

7

HP Z640 Workstation rear panel components

8

1

Power supply Built-In Self-Test
(BIST) LED

7

AMT-enabled network jack (orange)

2

Rear power button

8

Audio line-out jack (green)

3

PS/2 keyboard connector (purple)

9

Audio line-in jack (blue)

4

PS/2 mouse connector (light green)

10

PCI/PCIe card slots

5

USB 2.0 ports (2, black)

11

Power cord connector

6

USB 3.0 ports (4, blue)

12

Security slot
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HP Z840 Workstation components
HP Z840 Workstation front panel components

1

Optical drive

5

USB 3.0 charging port (1)

2

Optical drive bays

6

USB 3.0 ports (3)

3

Power button

7

Audio-out (headphone)/Audio-in
(microphone) combo jack

4

Hard drive activity light

8

Audio-in (microphone) jack

HP Z840 Workstation components

9

HP Z840 Workstation rear panel components

10

1

Power supply Built-In Self-Test (BIST) LED

8

USB 2.0 ports (2, black)

2

Rear power button

9

USB 3.0 ports (4, blue)

3

Serial connector (teal blue)

10

4

PS/2 keyboard connector (purple)

11

PCI/PCIe card slots

5

PS/2 mouse connector (light green)

12

Power cord connector

6

Audio line-out jack (green)

13

Security slot

7

Audio line-in jack (blue)

Chapter 2 Workstation features

Network jacks (2, orange)
Bottom connector is AMT enabled

Product specifications
Workstation weights and dimensions
Characteristic

Weight

Chassis dimensions
Tower configuration

HP Z440

HP Z640

HP Z840

Standard
configuration

13.20 kg
(29.10 lb)

17.90 kg
(39.46 lb)

23.50 kg
(51.90 lb)

Minimum
configuration

12.50 kg
(27.56 lb)

15.50 kg
(34.17 lb)

19.80 kg
(43.70 lb)

Maximum
configuration

17.70 kg
(39.02 lb)

22.60 kg
(49.82 lb)

28.90 kg
(63.60 lb)

Height

43.18 cm
(17.00 in)

44.40 cm
(17.50 in)

44.40 cm
(17.50 in)

Width

16.89 cm (6.65
in)

17.15 cm (6.75
in)

20.30 cm (8.00
in)

Depth

44.47 cm
(17.51 in)

46.99 cm
(18.50 in)

52.50 cm
(20.70 in)

Environmental specifications
Characteristic

HP Z440, Z640, and Z840 Workstations
Operating: 5°C to 35°C (40°F to 95°F)

Temperature

Non-operating: -40°C to 60°C (-40°F to 140°F)
NOTE:

Humidity

Altitude

Derate by 1°C (1.8°F) for every 305 m (1,000 ft) altitude over 1,524 m (5,000 ft).

Operating: 8% to 85% relative humidity, non-condensing
Non-operating: 8% to 90% relative humidity, non-condensing
Operating: 0 to 3,048 m (10,000 ft)
Non-operating: 0 to 9,144 m (30,000 ft)
Operating: ½-sine: 40 g, 2 to 3 ms
Non-operating:

Shock

●

½-sine: 160 cm/s, 2 to 3 ms (~100 g)

●

square: 422 cm/s, 20 g

NOTE:

Values represent individual shock events and do not indicate repetitive shock events.

Operating Random: 0.5 g (rms), 5 to 300 Hz
Vibration

Non-Operating: random: 2.0 g (rms), 10 to 500 Hz
NOTE:

Values do not indicate continuous vibration.

Product specifications
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3

Setting up the workstation
This chapter describes how to set up your workstation.
●

Ensuring proper ventilation

●

Setup procedures

●

Adding monitors

●

Installing optional components

●

Security

●

Product recycling

Ensuring proper ventilation
Proper ventilation for the system is important for workstation operation. Follow these guidelines:
●

Operate the workstation on a sturdy, level surface.

●

Provide at least 15.24 cm (6.00 in) of clearance at the front and back of the workstation. (This is the
minimum distance for all workstation models.)
NOTE: Your workstation may look slightly different from the illustration in this section.

●

12

Ensure that the ambient air temperature falls within the specifications listed in Environmental
specifications on page 11.
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●

For cabinet installation, ensure adequate cabinet ventilation and ensure that the ambient temperature
within the cabinet does not exceed specified limits.

●

Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air intakes,
as shown in the following figure.

Setup procedures
WARNING!

To reduce the risk of electric shock or damage to your equipment, observe these practices:

• Plug the power cord into an AC outlet that is easily accessible.
• Disconnect power from the workstation by unplugging the power cord from the AC outlet (not by unplugging
the power cord from the workstation).
• Plug the cord into a grounded (earthed) three-pin outlet. Do not disable the power cord grounding pin (for
example, by attaching a two-pin adapter). The grounding pin is an important safety feature.
NOTE: An HP Z840 Workstation with a 1125 W power supply might require more power than the typical
office environment can supply. For details, see the Site Preparation Guide for the workstation at
http://www.hp.com/support/workstation_manuals.
To set up the workstation:
1.

Connect the mouse, keyboard, and power cord to the workstation.

2.

Connect the monitor to the workstation.

3.

Connect other peripheral components (such as a printer) according to the instructions included with the
device.

4.

Connect a network cable to the workstation and to a network router or LAN device.

5.

Plug the workstation power cord and monitor power cord into an AC outlet.

Setup procedures
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Adding monitors
Planning for additional monitors
All graphics cards provided with HP Z series Workstations support two simultaneous-display monitors (see
Connecting and configuring monitors on page 17). Cards that support more than two monitors are available.
The process for adding monitors depends on your graphics card(s) and the type and number of monitors you
add.
Use this process to plan for adding more monitors.
1.

Assess your monitor needs.
●

Determine how many monitors you require.

●

Determine the kind of graphics performance you want.

●

Note the type of graphics connector used by each monitor. HP provides graphics cards with
DisplayPort (DP) and DVI interfaces, but you can use adapters and third-party cards to interface to
other graphics formats, including DVI-I, HDMI, or VGA.
TIP: Some adapters for older legacy hardware may cost more than others. You may want to
compare the cost of acquiring adapters with the cost of getting a newer monitor that doesn't need
adapters.

2.

Determine whether you need additional graphics cards.
●

Consult the graphics card documentation to determine how many monitors you can connect to the
card.
You may need to acquire adapters to match the card output to the monitor connector. (See
Matching graphics cards to monitor connectors on page 16.)
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●

If necessary, plan to acquire a new graphics card to support additional monitors.

●

The maximum number of monitors that a graphics card supports depends on the card. Most cards
provide outputs for two monitors. Some provide three or four outputs.

Chapter 3 Setting up the workstation

NOTE: Monitors with resolutions above 1920 x 1200 pixels at 60 Hz require a graphics card with
either Dual Link DVI (DL-DVI) or DisplayPort output. To get native resolution with DVI, you must use
a DL-DVI cable, not standard DVI-I or DVI-D cables.
HP workstations do not support all graphics cards. Be sure that a new graphics card is supported
before purchasing it. See Finding supported graphics cards on page 15.
Many graphics cards provide more than two monitor outputs but limit you to using only two at a
time. Consult the graphics card documentation or look up information on the card according to the
procedure in Finding supported graphics cards on page 15.
Some graphics cards support multiple monitors by multiplexing the monitor signal across multiple
outputs. This might reduce graphics performance. Consult the graphics card documentation or look
up information on the card according to the procedure in Finding supported graphics cards
on page 15.
Make sure the card outputs match the input required by the monitors. (See Identifying monitor
connection requirements on page 16.)
The different models of HP Z series Workstations have different limits on the mechanical size, data
speed, and power available for additional graphics cards. Note that the usual practical limit for
graphics cards is two per workstation. See the Maintenance and Service Guide for expansion card
slot identification to make sure a new graphics card will work for your workstation.
3.

If you want to add a new graphics card or cards:
a.

Determine which supported graphics card best fits your needs in terms of number of monitors,
compatibility with the monitors you plan to use, and performance. See Finding supported graphics
cards on page 15.

b.

Make sure you have the correct drivers for the card. See http://www.hp.com for HP-qualified
drivers.

c.

Install the graphics card according to the video instructions for your workstation at
http://www.hp.com/go/sml.

d.

Configure the monitor. For details, refer to Microsoft® Help or to http://www.microsoft.com.
For monitor setup in Linux, you can often use the settings tool for the graphics cards (e.g., NVIDIA
nvidia-settings or AMD Catalyst Control Center). In some recent Linux releases, the window
manager system (e.g., Gnome 3) preferences must also be modified.
TIP: To simplify troubleshooting of possible problems, enable the monitors one at a time: enable
the first monitor and make sure it works properly before enabling the next monitor.

Finding supported graphics cards
To find information about graphics cards supported for your workstation:
1.

Go to http://www.hp.com/go/qs/.

2.

Select Search active QuickSpecs, and then select Desktops & Workstations.

3.

Choose your model to view the specifications.

4.

Click the link for Technical Specifications-Graphics to display expanded technical information for
supported graphics cards, including how many monitors the card supports, connectors, power
consumption, drivers, and other details.
NOTE: Not all graphics cards are compatible with all video transceivers and adapters. See the graphics
card documentation for specific details.

Adding monitors
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Matching graphics cards to monitor connectors
The following table describes monitor configuration scenarios.
Monitor connector
Graphics card interface connector

DISPLAYPORT

DVI

Dual Link DVI

DisplayPort
(DP)

HDMI

DP to DVI
adapter

DP to DL DVI
adapter

DP cable

DP to HDMI
adapter

DVI to VGA
adapter

DVI cable

DL DVI cable

N/A

N/A

No adapter
required

DVI-I to VGA
adapter

N/A

N/A

N/A

DMS-59 to VGA
adapter

DMS-59 to DVI
adapter

N/A

DMS-59 to DP
adapter

N/A

VGA
DisplayPort to
VGA adapter
(sold
separately)

DVI—I (WHITE)

VGA (BLUE)

DMS-59*

*

This interface is a dual-monitor graphics interface card that supports two VGA, two DVI, or two DP monitors.

NOTE:

HP graphics cards include monitor cable adapters unless otherwise indicated.

DisplayPort connections have the highest performance; VGA connections have the lowest.

Identifying monitor connection requirements
The following are various scenarios for connecting monitors. ( See Matching graphics cards to monitor
connectors on page 16 for more information about the different graphics cards):
●

Graphics card with DisplayPort output — If the graphics card has four DisplayPort outputs, you can
connect a monitor to each connector. Use the proper adapters if required.

●

Graphics card with DVI output — If you have a graphics card with two DVI outputs, you can connect a
monitor to each connector. Use the proper adapters if required.
NOTE: Models that have only one DVI port always have a second graphics output option (DisplayPort
or VGA).
Many graphics cards provide more than two monitor outputs but limit you to using only two at a time.
Consult the graphics card documentation or look up information on the card according to the procedure
in Matching graphics cards to monitor connectors on page 16.
On a system with two DVI connections, port number 1 provides the primary display, which is where the
BIOS POST screen appears after a system boot. (Only one card is used during BIOS POST unless you
change the BIOS setting.)
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●

Graphics card with VGA and DL-DVI output — If the workstation does not have a PCIe graphics card, but
has one or more SVGA and/or DL-DVI outputs, you can connect a monitor to each output.

●

Graphics card with DMS-59 output — If the workstation has a PCIe graphics card with a DMS-59 output,
use the appropriate adapter to connect your monitor.
Adapters are available to connect the DMS-59 output to two DVI or two VGA monitors.

Connecting and configuring monitors
NOTE: The supported graphics cards typically allow at least two monitors, as shown in this section; some
supported cards allow more monitors. Refer to the graphics card documentation for details.
1.

Connect the monitor cable adapters (1) (if required) to the workstation, then connect the appropriate
monitor cables to the adapters (2) or directly to the graphics card.

2.

Connect the other ends of the monitor cables to the monitors.

3.

Connect one end of the monitor power cord to the monitor and the other end to an AC outlet.

4.

Configure the monitor. For details, refer to Microsoft Help or to http://www.microsoft.com.
For monitor setup in Linux, you can often use the settings tool for the graphics cards (e.g., NVIDIA
nvidia-settings or AMD Catalyst Control Center). In some recent Linux releases, the window manager
system (e.g., Gnome 3) preferences must also be modified.

Adding monitors
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Using a third-party graphics configuration utility
Third-party graphics cards may include a monitor configuration utility. Upon installation, this utility is
integrated into Windows. You can select the utility and use it to configure multiple monitors with your
workstation.
Refer to your graphics card documentation for details.
NOTE: Some third-party configuration utilities require that you enable the monitors in Windows before
using the configuration tool. Refer to your graphics card documentation for more information.
NOTE:

Monitor configuration utilities are also often available on the HP support website.

Customizing the monitor display (Windows)
You can manually select or change the monitor model, refresh rates, screen resolution, color settings, font
sizes, and power management settings.
●

To change display settings in Windows 7, right-click a blank area on the desktop, and then click Screen
Resolution.

●

To change display settings in Windows 8, point to the upper-right or lower-right corner of the Start
screen to display the charms, and then click PC Settings > PC and Devices > Display.

●

For Windows 8, you can also change the display settings by pointing to the upper-right or lower-right
corner of the Start screen to display the Charms menu, and then clicking Search > Settings, typing
resolution in the Settings search field, and clicking Change the Screen Resolution.

●

To change display settings in Windows 10, type control panel in the taskbar search box, and then
select Control Panel. Select Appearance and Personalization, and then select Display.

For more information about customizing your monitor display, see the following resources:
●

Online documentation provided with the graphics controller utility

●

Documentation included with your monitor

Installing optional components
Depending on the workstation model, additional components (such as memory, hard drives, optical drives,
PCIe cards, or a second processor) can be installed on your workstation.
●

To view component installation videos, go to http://www.hp.com/go/sml.

●

For installation guidelines and technical information, see the Maintenance and Service Guide for your
workstation at http://www.hp.com/support/workstation_manuals.

Security
Some HP workstations have a lock on the side access panel. The key for this lock is shipped attached to the
back panel of the workstation chassis.
Additional security features reduce the risk of theft and alert when there has been a chassis intrusion. See the
Maintenance and Service Guide for your workstation at http://www.hp.com/support/workstation_manuals for
information about additional hardware and software security features available for your system.
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Product recycling
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable
batteries.
For information about recycling HP components or products, go to http://www.hp.com/go/recycle.

Product recycling
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4

Setting up, backing up, restoring, and
recovering Windows 7
This chapter provides setup and update information for the Windows 7 operating system. It includes these
topics:
●

Setting up the Windows 7 operating system

●

Backing up, restoring, and recovering Windows 7

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the operating
system is successfully installed. Adding hardware might cause errors and prevent the operating system from
installing correctly.
NOTE: After you set up the operating system, be sure that the latest BIOS, drivers, and software updates are
installed on the workstation. See Updating the workstation on page 49.

Setting up the Windows 7 operating system
CAUTION: After installation has started, do not turn off the workstation until the process is complete.
Turning off the workstation during installation can damage the installation and operation of the software.
For complete installation and configuration instructions, go to http://windows.microsoft.com/en-US/
windows7/help. Additional information is available in the Windows 7 online Help after you successfully install
the operating system.

Installing or upgrading device drivers
You must install the appropriate device drivers before you install hardware devices. Follow the installation
instructions that came with each device. For optimum performance, your operating system must have the
most recent updates, patches, and service packs. See http://www.hp.com for HP-qualified drivers. For
additional driver and software update information, see Updating the workstation on page 49.
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Transferring files and settings
The Windows operating system offers data migration tools that help you select and transfer files and data
from one Windows-based workstation to another.
For information about these tools, go to http://www.microsoft.com.

Backing up, restoring, and recovering Windows 7
Your workstation includes tools provided by HP and Windows to help you safeguard your information and
retrieve it if you ever need to. These tools will help you return your workstation to a proper working state or
even back to the original factory state, all with simple steps.
This section provides information about the following processes:
●

Creating backups

●

Restoring and recovering your system

NOTE: For more details about the Windows Backup and Restore tools provided, see Help and Support. To
access Help and Support: select Start, and then select Help and Support.
Recovery after a system failure is only as good as your most recent backup.
1.

After you successfully set up the workstation, use Windows tools to create recovery media. In Windows
7, select Start > Control Panel > System and Security > Backup and Restore > Create a system image.

2.

As you add hardware and software programs, create system restore points. A system restore point is a
snapshot of certain hard drive contents saved by Windows System Restore at a specific time. A system
restore point contains information that Windows uses, such as registry settings. Windows creates a
system restore point for you automatically during a Windows update and during other system
maintenance activities (such as a software update, security scanning, or system diagnostics). You can
also manually create a system restore point at any time. For more information and steps for creating
specific system restore points, see Help and Support. To access Help and Support: select Start, and then
select Help and Support.

3.

As you add photos, video, music, and other personal files, create a backup of your personal information.
If files are accidentally deleted from the hard drive and they can no longer be restored from the Recycle
Bin, or if files become corrupted, you can restore the files that you backed up. In case of system failure,
you can use the backup files to restore the contents of your workstation. See Backing up your
information on page 22.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.

Backing up, restoring, and recovering Windows 7
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Backing up your information
NOTE: Windows includes the User Account Control feature to improve the security of your workstation. You
may be prompted by User Account Control for your permission or password when you perform certain tasks.
To continue a task, select the appropriate option. For information about User Account Control, see Help and
Support: select Start and then select Help and Support.
You should create your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably current
backup. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.
NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in
Help and Support. To access Help and Support: select Start and then select Help and Support.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up your information:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated directories.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

●

When backing up to discs, number each disc after removing it from the drive.

To create a backup using Windows Backup and Restore:
NOTE:

The backup process may take over an hour, depending on file size and the speed of the workstation.

1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup.

System Restore
If you have a problem that might be due to software that you installed on your workstation, use System
Restore to return the workstation to a previous restore point. You can also set restore points manually.
NOTE:

Always use this System Restore procedure before you use the System Recovery feature.

To start System Restore:
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1.

Close all open programs.

2.

Select Start, select Computer, and then select Properties.

3.

Select System protection > System Restore > Next, and then follow the on-screen instructions.
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System Recovery
CAUTION: This procedure will delete all user information. To prevent loss of information, be sure to back up
all user information so you can restore it after recovery.
Always use the System Restore procedure before you use the System Recovery program. See System Restore
on page 22.
System Recovery completely erases and reformats the hard disk drive, deleting all data files that you have
created, and then reinstalls the operating system, programs, and drivers. However, you must reinstall any
software that was not installed on the workstation at the factory. This includes software that came on media
included in the workstation accessory box, and any software programs that you have installed.
You can order a recovery media set from support. For U.S. support, go to http://www.hp.com/support. For
worldwide support, go to http://www8.hp.com/us/en/contact-hp/ww-contact-us.html. You can also order the
recovery media set by calling support.
NOTE: Some features might not be available on systems that are shipped without a Windows operating
system.
You must choose one of the following methods to perform a System Recovery:
●

Recovery image — Run System Recovery from a recovery image stored on your hard disk drive. The
recovery image is a file that contains a copy of the original factory-shipped software. To perform a
System Recovery from a recovery image, see System Recovery from a recovery partition image
on page 23.

●

Recovery media — Run System Recovery from recovery media that you have purchased separately.

System Recovery from a recovery partition image
CAUTION:

System Recovery deletes all data and programs that you have created or installed.

A Windows system from the HP factory ships with a recovery partition. You can use the recovery partition to
recover the factory operating system.
1.

Turn off the workstation. If necessary, press and hold the power button until the workstation turns off.

2.

Disconnect all peripheral devices from the workstation except the monitor, keyboard, and mouse.

3.

Press the power button to turn on the workstation.

4.

As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the Windows
is Loading Files... message appears on the screen.

5.

At the HP Recovery Manager screen, follow the on-screen instructions to continue.

6.

When Windows has loaded, shut down the workstation, reconnect all peripheral devices, and then turn
the workstation back on.

Using HP Recovery Disc operating system discs
CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and reformats
the hard drive. All files that you have created and any software that you have installed on the workstation are
permanently removed. When reformatting is complete, the recovery process helps you restore the operating
system, as well as the original drivers. Software that came with the system can be downloaded at
http://www.hp.com.
Use the steps provided in this section if you ordered a Windows 7 operating system DVD and Driver DVD.

Backing up, restoring, and recovering Windows 7
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To order a Windows 7 operating system DVD and Driver DVD, go to the HP website. For U.S. support, go to
http://www.hp.com/cgi-bin/hpsupport/index.pl. For worldwide support, go to http://www8.hp.com/us/en/
contact-hp/ww-contact-us.html. You can also order the DVDs by calling support.
To initiate recovery using a Windows 7 operating system DVD:
NOTE:

This recovery process takes several minutes.

1.

Backup all personal files.

2.

Restart the workstation, and then insert the Windows 7 operating system DVD into the optical drive.
NOTE: If the workstation does not boot to the DVD, restart the workstation and press Esc as the
workstation is powering on to see the startup menu. Use the arrow keys to select the boot menu and
press enter. Use the arrow keys to select the location where the recovery DVD is inserted to boot from
that device. Booting the DVD from UEFI Boot sources will result in a GPT boot partition. Booting from
Legacy Boot sources will result in an MBR boot partition.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

After the operating system installation has completed:
1.

Eject the Windows 7 operating system DVD, and insert the Driver DVD once the system is booted into the
OS for the first time.
NOTE: The Driver DVD will load prerequisite software, and then allow you to load drivers.
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2.

Install the Hardware Enabling Drivers. HP recommends installing all available drivers.

3.

You can download applications that came with the workstation at http://www.hp.com.
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Setting up, backing up, restoring, and
recovering Windows 8
This chapter provides setup and update information for the Windows 8 operating system. It includes these
topics:
●

Supplementary information

●

Setting up the Windows 8 operating system

●

Downloading Windows 8 updates

●

Backing up, restoring, and recovering Windows 8

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the operating
system is successfully installed. Adding hardware might cause errors and prevent the operating system from
installing correctly.
NOTE: After you set up the operating system, be sure that the latest BIOS, drivers, and software updates are
installed on the workstation. See Updating the workstation on page 49.

Supplementary information
Additional information is available in Help and Support after you customize the operating system.

Setting up the Windows 8 operating system
The first time you turn on the workstation you can customize the operating system. When you are connected
to the Internet, Microsoft activates your operating system. This process takes about 15 to 30 minutes.
Carefully read and follow the instructions on the screen.
We recommend that you register your workstation with HP, so you can receive important software updates,
request support, and sign up for special offers.
CAUTION: After the initial setup process has begun, DO NOT TURN OFF THE WORKSTATION UNTIL THE
PROCESS IS COMPLETE. Turning off the workstation during this process may damage the software that runs
the workstation or prevent its proper installation.
NOTE: Windows includes the User Account Control feature to improve the security of your workstation. You
may be prompted by User Account Control for your permission or password when you perform certain tasks.
To continue a task, select the appropriate option. For information about User Account Control, see Help and
Support: from the Start screen type help and then select Help and Support.

Supplementary information
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Downloading Windows 8 updates
Microsoft may release updates to the operating system. To help keep the workstation running optimally, HP
recommends checking for the latest updates during the initial installation and periodically throughout the life
of the workstation.
Run Windows Update as soon as possible after you set up your workstation.
1.

Point to the upper-right or lower-right corner of the Start screen to display the charms.

2.

Select Settings > Change PC Settings > Update and Recovery > Windows Update.

Backing up, restoring, and recovering Windows 8
Your workstation includes tools provided by HP and Windows to help you safeguard your information and
retrieve it if you ever need to. These tools will help you return your workstation to a proper working state or
even back to the original factory state, all with simple steps.
This section provides information about the following processes:
●

Creating recovery media and backups

●

Restoring and recovering your system

NOTE: For more details about the tools provided, see Help and Support. From the Start screen, type help,
and then select Help and Support.
HP recommends that you print the recovery procedures and save them for later use, in case of system
instability.

Backing up your information
NOTE: Windows includes the User Account Control feature to improve the security of your workstation. You
may be prompted by User Account Control for your permission or password when you perform certain tasks.
To continue a task, select the appropriate option. For information about User Account Control, from the Start
screen type help and then select Help and Support.
Recovery after a system failure is as good as your most recent backup. You should create system repair media
and your initial backup immediately after initial system setup. As you add new software and data files, you
should continue to back up your system on a regular basis to maintain a reasonably current backup. The
system repair media is used to start up (boot) the workstation and repair the operating system in case of
system instability or failure. Your initial and subsequent backups allow you to restore your data and settings
if a failure occurs.
NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in
Help and Support. To access Help and Support: from the Start screen, type help and then select Help and
Support.
From the Start screen, type backup, and then select Save backup copies of your files with File History.
You can back up your information to an optional external hard drive or a network drive.
Note the following when you perform a backup:
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●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Windows Backup and Restore:
NOTE: The backup process may take more than an hour, depending on file size and the speed of the
workstation.
1.

From the Start screen, type backup, and then select from the list of displayed options.

2.

Follow the on-screen instructions to set up your backup, create a system image, or create system repair
media.

Backing up, restoring, and recovering Windows 8
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Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.
CAUTION: Use a flash drive with a capacity of at least 8 GB. Any information on the USB flash drive will be
erased before the recovery media is created.
1.

After you successfully set up the workstation, create recovery media. This step creates a backup of the
recovery partition on the workstation. The backup can be used to reinstall the original operating system
in cases where the hard drive is corrupted or has been replaced.
You will use a USB flash drive to create a bootable recovery drive that can be used to troubleshoot a
Windows 8 workstation that is unable to start. The USB flash drive can be used to reinstall the original
operating system and the programs that were installed at the factory.
CAUTION: If you select Copy contents from the recovery partition to the recovery drive, you will
have the option to delete the recovery partition when the Recovery Media creation is finished. On most
systems, this partition is 10 GB in size. HP recommends that you not delete this recovery partition. If the
partition is deleted, you will be unable to restore the Windows 8 factory recovery partition to the hard
drive using the recovery USB drive. You can free up drive space by deleting the recovery partition, but
you won't be able to refresh or reset the PC again.
To create the recovery media, from the Start screen, type create a recovery drive, and then
select Create a recovery drive. Follow the on-screen instructions to continue.

2.

As you add hardware and software programs, create system restore points. A system restore point is a
snapshot of certain hard drive contents saved by Windows System Restore at a specific time. A system
restore point contains information that Windows uses, such as registry settings. Windows automatically
creates a system restore point for you during a Windows update and during other system maintenance
activities (such as a software update, security scanning, or system diagnostics). You can also manually
create a system restore point at any time. For more information and steps for creating specific system
restore points, see Windows Help and Support. From the Start screen, type help, and then select Help
and Support.

3.

As you add photos, video, music, and other personal files, create a backup of your personal information.
Windows File History can be set to regularly and automatically back up files from libraries, desktop,
contacts, and favorites. If files are accidentally deleted from the hard drive and they can no longer be
restored from the Recycle Bin, or if files become corrupted, you can use File History to restore the files
that you backed up. Restoring files is also useful if you ever choose to reset the workstation by
reinstalling Windows.
NOTE: File History is not enabled by default, so you must turn it on.
For more information and steps for enabling Windows File History, see Windows Help and Support. From
the Start screen, type help, and then select Help and Support.

Restoring and recovering using Windows 8 tools
Windows recovery tools provide access to several options for recovering your system. Choose the method
that best matches your situation and level of expertise:
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●

If you need to restore your personal files and data, you can use Windows File History to restore your
information from the backups you created. For more information and steps for using File History, see
Windows Help and Support. From the Start screen, type help, and then select Help and Support.

●

If you want to restore the system to a previous state without losing any personal information, Windows
System Restore is an option. System Restore allows you to restore without the requirements of Windows
Refresh or a reinstallation. Windows creates system restore points automatically during a Windows
update and other system maintenance events. Even if you did not manually create a restore point, you
can choose to restore to an automatically created restore point. For more information and steps for
using Windows System Restore, see Windows Help and Support. From the Start screen, type help, and
then select Help and Support.

●

If you want a quick and easy way to recover the system without losing your personal information,
settings, or the apps that came preinstalled on your workstation or were purchased from the Windows
Store, Windows Refresh is an option. This method does not require backing up data to another drive. See
Using Windows 8 Refresh on page 29.

●

If you want to reset your workstation to its original state, Windows Reset provides an easy way to
remove all personal data, apps, and settings, and reinstall Windows. The Reset recovery tool reinstalls
the operating system and HP programs and drivers that were installed at the factory. Software not
installed at the factory must be reinstalled. Any personal files must be restored from backups you made.
See Using Windows 8 Reset on page 30.

●

If the workstation is unable to start, you can use the Windows recovery USB flash drive you created to
recover the system. See Recovery using the Windows 8 recovery USB flash drive on page 31.

●

If the workstation is unable to start and you did not create a recovery USB flash drive or the one you
created does not work, see Recovery using Windows 8 restore media on page 32.

Using Windows 8 Refresh
IMPORTANT: Refresh removes any traditional applications that were not originally installed on the system
at the factory.
NOTE: You may be prompted by User Account Control for your permission or password when you perform
certain tasks. To continue a task, select the appropriate option. For information about User Account Control,
see Help and Support: from the Start screen type help, and then select Help and Support.
If Windows is responding, use these steps to start Refresh:
NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a quick way
to see what you might need to reinstall. See Help and Support for instructions on reinstalling traditional
applications. From the Start screen, type help, and then select Help and Support.
1.

On the Start screen, point to the far-right upper or lower corner of the screen to display the charms.

2.

Select Settings.

3.

Select Change PC settings in the bottom-right corner of the screen, and then select Update and
Recovery > Recovery from the PC settings screen.

4.

Under Refresh your PC without affecting your files, select Get started, and follow the on-screen
instructions.

If Windows is not responding, use these steps to start Refresh:

Backing up, restoring, and recovering Windows 8
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1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: from the Start screen, type This PC,
and then select This PC.
NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must recover
using the recovery media that you created. See Recovery using the Windows 8 recovery USB flash drive
on page 31. If you did not create recovery media, you must use the Windows 8 restore media (available
separately). See Recovery using Windows 8 restore media on page 32.

3.

If the HP Recovery partition is listed, restart the workstation, and then press Esc while the company logo
is displayed. The workstation Startup Menu opens.

4.

Press F11 to select the System Recovery option.

5.

Choose your keyboard layout.

6.

Select Troubleshoot.

7.

Select Refresh.

8.

Follow the on-screen instructions to continue.

Using Windows 8 Reset
IMPORTANT: Reset does not provide backups of your information. Before using Reset, back up any personal
information you want to retain.
If Windows is responding, use these steps to start Reset:
NOTE: You may be prompted by User Account Control for your permission or password when you perform
certain tasks. To continue a task, select the appropriate option. For information about User Account Control,
see Help and Support: from the Start screen type help, and then select Help and Support.
1.

On the Start screen, point to the far-right upper or lower corner of the screen to display the charms.

2.

Select Settings.

3.

Select Change PC settings in the bottom-right corner of the screen, select Update and Recovery then
select Recovery.

4.

Under Remove everything and reinstall Windows, select Get started, and follow the on-screen
instructions.

If Windows is not responding, use these steps to start Reset:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: from the Start screen, type This PC,
and then select This PC.
NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must recover
using the recovery media that you created. See Recovery using the Windows 8 recovery USB flash drive
on page 31. If you did not create recovery media, you must use the Windows 8 restore media (available
separately). See Recovery using Windows 8 restore media on page 32.
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3.

If the HP Recovery partition is listed, restart the workstation, and then press Esc while the company logo
is displayed. The workstation Startup Menu opens.

4.

Press F11 to select the System Recovery option.

5.

Choose your keyboard layout.
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6.

Select Troubleshoot.

7.

Select Reset.

8.

Follow the on-screen instructions to continue.

Recovery using the Windows 8 recovery USB flash drive
CAUTION: Using F11 completely erases hard drive contents and reformats the hard drive. All files that you
have created and any software that you have installed on the workstation are permanently removed. The F11
recovery tool reinstalls the operating system and the HP programs and drivers that were installed at the
factory. You must reinstall all other software.
To recover your system using the recovery USB flash drive you previously created:
NOTE: If you did not create a recovery USB flash drive or the one you created does not work, see Recovery
using Windows 8 restore media on page 32.
1.

If possible, back up all personal files.

2.

Insert the recovery USB flash drive into a USB port on your workstation.

3.

Restart the workstation and as soon as you see the HP logo screen, press F9 to display a list of boot
devices. Use the arrow keys to select your USB flash drive from the UEFI Boot Sources list. Press enter.

4.

Choose your keyboard layout.

5.

Select Troubleshoot.

6.

Select Refresh your PC.

7.

Follow the on-screen instructions.

Backing up, restoring, and recovering Windows 8
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Recovery using Windows 8 restore media
This recovery process requires Windows 8 restore discs, which can be ordered from the support website. The
Windows 8 restore media consists of a Windows 8 operating system disc and a Windows 8 driver disc.
For U.S. support, go to http://www.hp.com/support. For worldwide support, go to
http://www8.hp.com/us/en/contact-hp/ww-contact-us.html. You can also order the media by calling support.
CAUTION: Using the Windows 8 operating system disc completely erases hard drive contents and reformats
the hard drive. All files that you have created and any software that you have installed on the workstation are
permanently removed. When reformatting is complete, the recovery process helps you restore the operating
system, as well as drivers.
Begin recovery using the Windows 8 operating system disc:
NOTE:

It can take several minutes to load the operating system disc.

1.

Back up all personal files.

2.

Restart the workstation, and then follow the instructions provided with the Windows 8 operating system
disc to install the operating system.

3.

When prompted, press any keyboard key.
NOTE: If the workstation does not boot to the DVD, restart the workstation and press Esc as the
workstation is starting to see the Startup menu. Use the arrow keys to select the boot menu, and then
press enter. Use the arrow keys to select the location where the recovery DVD is inserted to boot from
that device. Booting the DVD from UEFI Boot sources will result in a GPT boot partition. Booting from
Legacy Boot sources will result in an MBR boot partition. It is recommended that you boot Windows 8
from UEFI Boot sources to take full advantage of the features available in Windows 8.

4.

Follow the on-screen instructions.

After the repair is completed and the Windows 8 desktop appears:
1.

Remove the Windows 8 operating system disc, and then insert the driver disc.
NOTE: The driver disc will load prerequisite software, and then allow you to load drivers.
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2.

Install the Hardware Enabling Drivers first. HP recommends installing all available drivers.

3.

You can download applications that come with the workstation at http://www.hp.com.
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Setting up, backing up, restoring, and
recovering Windows 10
This chapter provides setup and update information for the Windows 10 operating system. It includes these
topics:
●

Activating and customizing the software

●

Turning off the workstation

●

Finding more information

●

If you encounter issues

Activating and customizing the software
Additional information is available in online help after you activate the operating system.
NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to permit
the required airflow.

Initial Windows operating system setup
The first time you turn on the workstation, the operating system is set up and activated automatically. This
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to complete the
initial Windows setup.
We recommend that you register your workstation with HP during operating system set up so you can receive
important software updates, facilitate support questions, and sign up for special offers.
CAUTION: After the setup process has begun, DO NOT TURN OFF THE WORKSTATION UNTIL THE PROCESS IS
COMPLETE. Turning off the workstation during the setup process may damage the software that runs the
workstation or prevent its proper installation.

Customizing the monitor display
If you wish, you can select or change the monitor refresh rates, screen resolution, color settings, font sizes,
and power management settings.
For more information, see the online documentation provided with the graphics controller utility or the
documentation that came with your monitor.
▲

Right-click on the Windows desktop, then click Personalize or Screen resolution to change display
settings.
– or –
Click the Start icon, click Settings, and the click Personalization.

Turning off the workstation
To properly turn off the workstation, shut down the operating system software.

Activating and customizing the software
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▲

Click the Start icon, click the Power icon, and then select Shut down.
– or –
From the taskbar, type settings, select Settings, type shut, and then click Turn off your PC.

Finding more information
NOTE:

Some or all of the following documents are available on the workstation hard drive.

●

Getting Started—Helps you connect the workstation and peripheral devices and set up factory-provided
software; also includes basic troubleshooting information should you encounter any problems during
initial startup.

●

Hardware Reference Guide—Provides an overview of the product hardware, as well as instructions for
upgrading this series of workstation; includes information on RTC batteries, memory, and power supply.

●

Maintenance and Service Guide (English only)—Provides information on parts removal and replacement,
troubleshooting, Desktop Management, setup utilities, safety, routine care, connector pin assignments,
POST error messages, diagnostic indicator lights and error codes.

●

Regulatory, Safety and Environmental Notices—Provides safety and regulatory information that
ensures compliance with U.S., Canadian, and various international regulations.

If you encounter issues
There are several means to diagnose and resolve potential issues. HP provides several proprietary
diagnostics tools but recommends a sequential troubleshooting approach that addresses the most basic root
cause to the more complex. Steps include:
●

Visual inspection

●

Blink or beep codes

●

HP PC Hardware Diagnostics

●

HP Support

●

System restore

●

System recovery

Performing basic troubleshooting
You can find troubleshooting information in the comprehensive Maintenance and Service Guide (English only)
available under the reference library at http://www.hp.com/support. Select Get software and drivers, enter
the model number of the workstation, and click Find my product.

Visual inspection: No boot, no power, no video
If you encounter problems with the workstation, monitor, or software, see the following list of general
suggestions before taking further action:
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●

Check that the workstation and monitor are plugged into a working electrical outlet.

●

Check to see that the voltage select switch (some models) is set to the appropriate voltage for your
region (115V or 230V).

●

Check to see that the workstation is turned on and the power light is on.
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●

Check to see that the monitor is turned on and the monitor light is on.

●

Turn up the brightness and contrast controls of the monitor if the monitor is dim.

●

If the system does not boot, press and hold any key. If the system beeps, then the keyboard is operating
correctly.

●

Check all cable connections for loose connections or incorrect connections.

●

Wake the workstation by pressing any key on the keyboard or pressing the power button. If the system
remains in sleep mode, shut down the workstation by pressing and holding the power button for at least
four seconds. Then press the power button again to restart the workstation. If the system will not shut
down, unplug the power cord, wait a few seconds, and then plug it in again. The workstation will restart
if automatic start on power loss is set in Computer Setup. If the workstation does not restart, press the
power button.

●

Reconfigure your workstation after installing a non-Plug and Play expansion board or other option.

●

Be sure that all the needed device drivers have been installed. For example, if you are using a printer,
you need a driver for that printer model.

●

Remove any bootable media (CD/DVD or USB device) from the system before turning it on.

●

If you have installed an operating system other than the factory-installed operating system, check to be
sure that it is supported on the system.

●

If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed (embedded
video on some models only) and a single monitor, the monitor must be connected to the monitor port on
the source that is set as the primary video source. During boot, the other video ports are disabled and if
the monitor is connected to one of these ports, the monitor will not function. You can select or change
the primary video source in Computer Setup.

CAUTION: When the workstation is plugged into an AC power source, there is always voltage applied to the
system board. To reduce the risk of system board or component damage, always disconnect the power cord
from the power source before opening the workstation.

Blink or beep codes: Interpreting POST diagnostic front panel LEDs and audible codes
If you see flashing LEDs on the front of the workstation or if you hear beeps, see the Maintenance and Service
Guide (English only) for interpretation and recommended action.

Before you call for technical support
WARNING! When the workstation is plugged into an AC power source, voltage is always applied to the
system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to
disconnect the power cord from the wall outlet and allow the internal system components to cool before you
touch them.
If you are having problems with the workstation, try the appropriate solutions as described in the previous
sections and summarized below to try to isolate the exact problem before calling for technical support.
●

Check the power LED on the front of the workstation to see if it is flashing and listen for a series of
beeps emanating from the workstation. The flashing lights and/or beeps are error codes that will help
you diagnose the problem. See the Maintenance and Service Guide (English only) for details.

●

If the screen is blank, plug the monitor into a different video port on the workstation if one is available.
Or, replace the monitor with a monitor that you know is functioning properly.

●

If you are working on a network:

If you encounter issues

35

—

Use a different network cable to connect your workstation to the network.

—

Connect a different workstation with a different cable to the network.

If your problem is not resolved, the network jack on your workstation or the network wall jack might be
faulty.
●

If you recently added new hardware, remove the hardware.

●

If you recently installed new software, uninstall the software.

●

Comprehensive online technical support is also available at http://www.hp.com/support.

●

If the workstation will turn on but will not boot into the operating system, you may run the “pre-boot”
diagnostics utility, HP PC Hardware Diagnostics.

●

If the workstation will boot into the operating system, there are two possible tools that provide selfsolve diagnostics and online chat features (if internet access is also available).
—

If you have HP Support Assistant, you may access it from the Start screen by clicking the HP
Support Assistant app, clicking My computer, and then clicking Diagnostics.

—

If you do not have HP Support Assistant installed, you may access HP Instant Support Professional
Edition at http://www.hp.com/go/ispe.

You may also access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest
online support information, software and drivers, for proactive notification, and access to a worldwide
community of peers and HP experts.
Comprehensive online technical support is also available at http://www.hp.com/support.
If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that your
service call is handled properly:
●

Be in front of your workstation when you call.

●

Before calling, write down the product ID number, workstation and monitor serial numbers, and the
failure ID produced by running the diagnostics if applicable.

●

Spend time troubleshooting the problem with the service technician.

●

Remove any hardware that was recently added to your system.

●

Remove any software that was recently installed.

NOTE: For sales information and warranty upgrades (HP Care Packs), call your local authorized service
provider or dealer.

Backing up, restoring, and recovering in Windows 10
This section provides information about the following processes. The information in the section is standard
procedure for most products.
●

Creating recovery media and backups

●

Restoring and recovering your system

For additional information, see Help and Support.
▲
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Type help in the taskbar search box, and then select Help and Support.
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Creating recovery media and backups
The following methods of creating recovery media and backups are available on select products only. Choose
the available method according to your workstation model.
●

Use HP Recovery Manager to create HP Recovery media after you successfully set up the workstation.
This step creates a backup of the HP Recovery partition on the workstation. The backup can be used to
reinstall the original operating system in cases where the hard drive is corrupted or has been replaced.
For information on creating recovery media, see Creating HP Recovery media (select products only)
on page 37. For information on the recovery options that are available using the recovery media, see
Using Windows tools on page 39.

●

Use Windows tools to create system restore points and create backups of personal information.
For more information, see Recovering using HP Recovery Manager on page 39.

NOTE:

If storage is 32 GB or less, Microsoft System Restore is disabled by default.

Creating HP Recovery media (select products only)
If possible, check for the presence of the Recovery partition and the Windows partition. From the Start menu,
select File Explorer.
●

If your workstation does not list the Windows partition and the Recovery partition, you can obtain
recovery media for your system from support. See the Worldwide Telephone Numbers booklet included
with the workstation. You can also find contact information on the HP website. Go to
http://www.hp.com/support, select your country or region, and follow the on-screen instructions.
You can use Windows tools to create system restore points and create backups of personal information,
see Using Windows tools on page 39.

●

If your workstation does list the Recovery partition and the Windows partition, you can use HP Recovery
Manager to create recovery media after you successfully set up the workstation. HP Recovery media can
be used to perform system recovery if the hard drive becomes corrupted. System recovery reinstalls the
original operating system and software programs that were installed at the factory and then configures
the settings for the programs. HP Recovery media can also be used to customize the system or restore
the factory image if you replace the hard drive.
○

Only one set of recovery media can be created. Handle these recovery tools carefully, and keep
them in a safe place.

○

HP Recovery Manager examines the workstation and determines the required storage capacity for
the media that will be required.

○

To create recovery discs, your workstation must have an optical drive with DVD writer capability,
and you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use
rewritable discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray)
discs; they are not compatible with HP Recovery Manager software. Or, instead, you can use a highquality blank USB flash drive.

○

If your workstation does not include an integrated optical drive with DVD writer capability, but you
would like to create DVD recovery media, you can use an external optical drive (purchased
separately) to create recovery discs. If you use an external optical drive, it must be connected
directly to a USB port on the workstation; the drive cannot be connected to a USB port on an
external device, such as a USB hub. If you cannot create DVD media yourself, you can obtain
recovery discs for your workstation from HP. See the Worldwide Telephone Numbers booklet
included with the workstation. You can also find contact information on the HP website. Go to
http://www.hp.com/support, select your country or region, and follow the on-screen instructions.

If you encounter issues
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○

Be sure that the workstation is connected to AC power before you begin creating the recovery
media.

○

The creation process can take an hour or more. Do not interrupt the creation process.

○

If necessary, you can exit the program before you have finished creating all of the recovery DVDs.
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery
Manager, you will be prompted to continue.

To create HP Recovery media:
1.

Type recovery in the taskbar search box, and then select HP Recovery Manager.

2.

If prompted, click Yes to allow the program to continue.

3.

Select Create recovery media, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 39.

38

Chapter 6 Setting up, backing up, restoring, and recovering Windows 10

Using Windows tools
You can create recovery media, system restore points, and backups of personal information using Windows
tools.
NOTE:

If storage is 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see Help and Support.
▲

Type help in the taskbar search box, and then select Help and Support.

Restore and recovery
There are several options for recovering your system. Choose the method that best matches your situation
and level of expertise:
IMPORTANT:
●

Windows offers several options for restoring from backup, refreshing the workstation, and resetting the
workstation to its original state. For more information see Help and Support.
▲

●

Not all methods are available on all products.

Type help in the taskbar search box, and then select Help and Support.

If you need to correct a problem with a preinstalled application or driver, use the Reinstall drivers and/
or applications option (select products only) of HP Recovery Manager to reinstall the individual
application or driver.
▲

Type recovery in the taskbar search box, select HP Recovery Manager, select Reinstall drivers
and/or applications, and then follow the on-screen instructions.

●

If you want to recover the Windows partition to original factory content, you can choose the System
Recovery option from the HP Recovery partition (select products only) or use the HP Recovery media.
For more information, see Recovering using HP Recovery Manager on page 39. If you have not already
created recovery media, see Creating HP Recovery media (select products only) on page 37.

●

On select products, if you want to recover the workstation’s original factory partition and content, or if
you have replaced the hard drive, you can use the Factory Reset option of HP Recovery media. For more
information, see Recovering using HP Recovery Manager on page 39.

●

On select products, if you want to remove the recovery partition to reclaim hard drive space, HP
Recovery Manager offers the Remove Recovery Partition option.
For more information, see Removing the HP Recovery partition (select products only) on page 41.

Recovering using HP Recovery Manager
HP Recovery Manager software allows you to recover the workstation to its original factory state by using the
HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery
partition (select products only). If you have not already created recovery media, see Creating HP Recovery
media (select products only) on page 37.
What you need to know before you get started
●

HP Recovery Manager recovers only software that was installed at the factory. For software not provided
with this workstation, you must either download the software from the manufacturer's website or
reinstall the software from the media provided by the manufacturer.

If you encounter issues
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IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct
workstation issues.
●

HP Recovery media must be used if the workstation hard drive fails. If you have not already created
recovery media, see Creating HP Recovery media (select products only) on page 37.

●

To use the Factory Reset option (select products only), you must use HP Recovery media. If you have not
already created recovery media, see Creating HP Recovery media (select products only) on page 37.

●

If your workstation does not allow the creation of HP Recovery media or if the HP Recovery media does
not work, you can obtain recovery media for your system from support. See the Worldwide Telephone
Numbers booklet included with the workstation. You can also find contact information from the HP
website. Go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions.

IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before
beginning recovery, back up any personal data you want to retain.
Using HP Recovery media, you can choose from one of the following recovery options:
NOTE:

Only the options available for your workstation display when you start the recovery process.

●

System Recovery—Reinstalls the original operating system, and then configures the settings for the
programs that were installed at the factory.

●

Factory Reset—Restores the workstation to its original factory state by deleting all information from
the hard drive and re-creating the partitions. Then it reinstalls the operating system and the software
that was installed at the factory.

The HP Recovery partition (select products only) allows System Recovery only.
Using the HP Recovery partition (select products only)
The HP Recovery partition allows you to perform a system recovery without the need for recovery discs or a
recovery USB flash drive. This type of recovery can be used only if the hard drive is still working.
To start HP Recovery Manager from the HP Recovery partition:
1.

Type recovery in the taskbar search box, select Recovery Manager, and then select HP Recovery
Environment.
- or Press f11 while the workstation boots, or press and hold f11 as you press the power button.

2.

Select Troubleshoot from the boot options menu.

3.

Select Recovery Manager, select System Recovery, and then follow the on-screen instructions.

Using HP Recovery media to recover
You can use HP Recovery media to recover the original system. This method can be used if your system does
not have an HP Recovery partition or if the hard drive is not working properly.
1.

If possible, back up all personal files.

2.

Insert the HP Recovery media, and then restart the workstation.
NOTE: If the workstation does not automatically restart in HP Recovery Manager, change the
workstation boot order. See Changing the workstation boot order on page 41.

3.
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Follow the on-screen instructions.
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Changing the workstation boot order
If your workstation does not restart in HP Recovery Manager, you can change the workstation boot order,
which is the order of devices listed in BIOS where the workstation looks for startup information. You can
change the selection to an optical drive or a USB flash drive.
To change the boot order:
1.

Insert the HP Recovery media.

2.

Access BIOS.
Restart the workstation, quickly press esc, and then press f9 for boot options.

3.

Select the optical drive or USB flash drive from which you want to boot.

4.

Follow the on-screen instructions.

Removing the HP Recovery partition (select products only)
HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.
IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery
or create HP recovery media from the HP Recovery partition. So before you remove the Recovery partition,
create HP Recovery media; see Creating HP Recovery media (select products only) on page 37.
NOTE:

The Remove Recovery Partition option is only available on products that support this function.

Follow these steps to remove the HP Recovery partition:
1.

Type recovery in the taskbar search box, and then select HP Recovery Manager.

2.

Select Remove Recovery Partition, and then follow the on-screen instructions.

If you encounter issues
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Setting up and restoring Linux
HP offers a variety of Linux solutions for HP workstation customers:
●

HP certifies and supports Red Hat® Enterprise Linux (RHEL) on HP workstations.

●

HP certifies and supports SUSE Linux Enterprise Desktop (SLED) on HP workstations.

●

HP certifies and supports Canonical Ubuntu on HP Workstations.

●

HP offers a SLED 11 preload on some Z series Workstations.

●

HP offers an Ubuntu preload on some Z series Workstations.

This chapter describes how to set up and restore the Linux operating system. It includes these topics:
●

HP Installer Kit for Linux (HPIKL)

●

Setting up Red Hat Enterprise Linux

●

Setting up SUSE Linux Enterprise Desktop (SLED)

●

Setting up Ubuntu

●

Proprietary graphics drivers

NOTE: After you set up the operating system, be sure that the latest BIOS, drivers, and software updates are
installed. See Updating the workstation on page 49.
CAUTION: Do not add optional hardware or third-party devices to the workstation until the operating
system is successfully installed. Adding hardware might cause errors and prevent the operating system from
installing correctly.
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HP Installer Kit for Linux (HPIKL)
The HP Installer Kit for Linux helps users install certified versions of RHEL, SLED, or Ubuntu on HP
workstations. It is available as an operating system option on all HP workstations.
●

The kit contains tested drivers that augment and/or replace those found in RHEL, SLED, or Ubuntu, to
enable proper use and behavior on HP workstations.

●

The kit does not include the Linux operating system, which the user must supply. Commercial Linux
distributions are available for purchase from vendors such as Red Hat and SUSE. A variety of other Linux
distributions are available for free (e.g., Ubuntu). To view supported configurations and operating
systems, go to http://www.hp.com/support/linux_hardware_matrix.

The HPIKL option may include a FreeDOS preload. This operating system option accommodates those who
have a customized Linux distribution or who have a licensed version of RHEL, SLED, or Ubuntu and would like
to install the HP-recommended driver additions.
The kit also can be downloaded using the following steps:
1.

Go to http://www.hp.com/support/workstation_swdrivers.

2.

Select your workstation model.

3.

Select the desired operating system.

4.

Select your software/driver language, and then click the Software quick jump link.

5.

Select the Obtain Software link for the appropriate package (typically the most recent revision).

6.

Click I Accept to accept the terms of the license agreement.

7.

Download the software ISO image and save it on a disc. This disk is your HP driver disc.

Setting up Red Hat Enterprise Linux
HP Z series Workstations are certified and supported on RHEL streams appropriate to the hardware
technology.
●

For details of RHEL support for a particular platform, see the Linux Hardware Matrix for HP Workstations
at http://www.hp.com/support/linux_hardware_matrix.

●

For information about Red Hat certifications on HP workstations, go to https://hardware.redhat.com.

HP Installer Kit for Linux (HPIKL)

43

HPIKL driver disc
Recent versions of Red Hat Linux typically require only driver updates with minor fixes to support HP
workstations. These releases can usually be supported with the HPIKL driver disc, which can be used as a
post-installation utility for the standard Red Hat Linux install.
After you complete the standard Red Hat install and restart the system, a Red Hat first-boot utility runs. After
you specify a number of settings (such as the security level, time and date, ‘root’ password, and user
accounts), the utility lets you load an additional disc.
The driver disc is used during this phase. All content added by HP is in the /HP directory on the disc. You can
use it to build your own image or to browse the HP content.
Please see /HP directory on the disk for any last-minute README pointers for elements on the disk.
NOTE: Some installations may encounter problems if they are performed with a DisplayPort connection to
the monitor. This is because the default drivers that the OS installers use do not support DisplayPort
functionality. If you experience problems, try overriding the monitor choice for DisplayPort during the start of
the install and using the VESA driver instead. You can then set up the DisplayPort monitor later.

Installing with the HP Red Hat Linux driver disc
1.

If you do not have the appropriate HP driver disc for a supported stream, create one (see HP Installer Kit
for Linux (HPIKL) on page 43.)

2.

Install the operating system using the optical media included in the Red Hat Linux box-set.

3.

If you have a Red Hat driver disk for the OS version you are installing, enter linux dd when the initial
install splash screen appears, and then press Enter.

4.

When asked if you have a driver disc, select Yes. Place the Red Hat driver disc in the drive, and select the
appropriate drive:hd[abcd]. Continue the normal installation.

5.

After successfully installing the operating system, reboot the workstation.
●
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RHEL 6 or RHEL 7: Insert your HP driver disc. The HPIKL installation software automatically starts.
Follow the on-screen instructions to install the contents.
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Setting up SUSE Linux Enterprise Desktop (SLED)
HP offers a 64-bit SLED 11 preload on some Z series Workstations and supports 64-bit SLED 11 on other
workstations.
Various versions of SLED are certified and supported by SUSE on HP workstations. For more information, go to
the SUSE certification bulletin search page at https://www.suse.com/yessearch/Search.jsp.

Setting up preloaded SLED
To set up SLED on systems preloaded with the operating system:
1.

Start the workstation.

2.

When prompted, enter the workstation installation settings: password, network, graphics, time,
keyboard settings, and SUSE Customer Center Configuration.
NOTE: You can activate your SUSE subscription from the SUSE Customer Center Configuration screen.
To view the full SUSE Customer Center documentation, go to http://www.suse.com/documentation, and
select your operating system.

Installing SLED with the DVD Installer Kit
1.

If an HP driver disc did not come with your workstation, create one (see HP Installer Kit for Linux (HPIKL)
on page 43).

2.

Install the operating system using the discs included in the SUSE box-set.

3.

After successfully installing the operating system, reboot the workstation.

4.

Insert your HP driver disc. The HPIKL installation software automatically starts. Follow the on-screen
instructions to install the contents.

Setting up SUSE Linux Enterprise Desktop (SLED)
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Restoring SLED (preloaded systems only)
To restore SLED, you must use the SLED restore media. To create restore media:
1.

Click the SUSE ISO icon on the desktop to go to the /iso folder. This folder contains all ISO images used to
preload your workstation.

2.

Follow the instructions in the readme file in this folder to copy the ISO image file onto optical media.

3.

Store the media in a safe place. If your workstation experiences a hard drive failure, use the ISO recovery
images to restore your operating system.

CAUTION: Restoring the operating system does not restore data. Back up your data using the method and
media of your choice.

Setting up Ubuntu
HP offers a 64-bit Ubuntu 14.04 LTS preload on some Z series Workstations and supports 64-bit Ubuntu
14.04 on other workstations.
Various versions of Ubuntu are certified and supported by Canonical on HP workstations. For more
information, go to the Ubuntu Desktop certified hardware search page at http://www.ubuntu.com/
certification/desktop/make/HP/?category=Desktop and filter the list using the word “Workstation”.

Setting up preloaded Ubuntu
To set up Ubuntu on systems preloaded with the operating system:
1.

Start the workstation.
The system boots and performs some setup activities in a non-interactive mode.
The system then reboots and plays a short video. After the video, an initial set of settings dialogs are
presented.

2.

When prompted, enter the desired language and keyboard settings, time zone, first user name and
identity, and the user password.
NOTE: This initial user has privileges to become system administrator using the sudo command. There
is no user root in the typical Ubuntu installation.
After completion of the setup, the login screen appears.

3.

Type the login information in the fields.

Using the HP Installer Kit Driver Disk
Ubuntu does not require registration to obtain software package updates. Updates can be obtained from
various “repositories” on the web using a variety of tools built into the OS. An internet connection and proxy
are all that may be required.
The HP Installer Kit for Linux driver disk for Ubuntu relies on the same mechanisms in order to satisfy
dependencies during installation. So the same internet access is needed, as well as capability to elevate from
the current user session to administrator privileges.
In some cases, HP-tested proprietary graphics drivers may be the only “payload” delivered by the driver disk.
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1.

Install the operating system from your own installation media.
Ubuntu is available at no cost from www.ubuntu.com.

2.

Restart the workstation.

3.

Insert your HP driver disc. The HPIKL installation software automatically starts.

4.

When prompted for the administrator password, type the password in the field.

5.

Follow the onscreen instructions to install the drivers appropriate to your hardware configuration.

Restoring Ubuntu (preloaded systems only)
There are several methods available for restoration of the initial factory image. All assume the installed
image is in a functional state (at least initially).
CAUTION: System image restoration involves repartitioning and rewriting the image. Applications and
drivers will have to be reinstalled afterwards. The F11 and boot-loader methods described below offer you
the option to have your /home data saved across the restoration. Data and configuration information in other
file trees (such as /etc) are not preserved.
Restoring the operating system does not restore data. Back up your data using the method and media of your
choice.

Create a restore disk or drive key
The initial image includes a tool that can create a restore image as an ISO file, which can then be burned to a
bootable DVD or copied to a USB drive key. Taking this action is advisable to have media to use should the
boot drive need to be replaced.
To create the ISO:
1.

Log in and go to the DASH interface that helps you find applications.

2.

Type recovery in the field and choose recovery-media-creator.
The application starts and prompts you for the password to grant administrator privileges. It also asks
where to write the ISO file.

3.

After ISO creation is complete, copy or burn the ISO to your desired medium.

Use the F11 function key during system boot
While the system BIOS is initially booting, the F11 key can be pressed to go into a restoration process for the
hard drive image.

Intercept the boot loader and choose the restore option
When the system boot has proceeded past the BIOS prompts, a purple border appears on the screen for a
short time. If the OS boot loader is interrupted at this point using the Esc key, you should be presented with a
short menu including a restore option.

Proprietary graphics drivers
Most HP workstations can be ordered with graphics cards that have been through extensive verification by HP.
See the Linux Hardware Matrix for HP Workstations at http://www.hp.com/support/linux_hardware_matrix
for a list of supported cards.

Proprietary graphics drivers
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NOTE: Not all graphics cards are available on every workstation. Limitations generally occur for cards that
consume large amounts of power in lower-power workstations.
Third-party proprietary graphics drivers supported by HP and the graphics vendors are available with the HP
Installer Kit for Linux, with the SLED 11 and Ubuntu preloads on Z series Workstations, and from HP
Workstation Support at http://www.hp.com/go/workstationsupport.
These proprietary drivers are not a standard part of the RHEL, SLED, or Ubuntu distributions because they are
not open source. Driver revisions more recent than those at the HP support website are supported directly by
the vendor.
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Updating the workstation
●

Updating the workstation after first boot

●

Updating the BIOS

●

Upgrading device drivers

HP is constantly working on improving your total workstation experience. To ensure that the workstation
leverages the latest enhancements, HP recommends that you install the latest BIOS, driver, and software
updates on a regular basis.

Updating the workstation after first boot
After successfully booting the workstation for the first time, follow these guidelines to be sure that the
workstation is up-to-date:
●

Be sure that you have the latest system BIOS version loaded. See Updating the BIOS on page 49.

●

Be sure that you have the latest drivers for your system. See Upgrading device drivers on page 50.

●

Become familiar with your available HP resources.

●

Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Updating the BIOS
For optimum performance, determine the BIOS version on the workstation, and upgrade it if necessary.

Determining the current BIOS version
To determine the current BIOS version:
1.

Press Esc during startup (boot).

2.

Press F10 to enter the F10 Setup utility.

3.

Select File > System Information. Note the workstation BIOS version.
NOTE: For procedures for upgrading the BIOS as well as the F10 Setup utility BIOS Menu settings, see
the Maintenance and Service Guide at http://www.hp.com/support/workstation_manuals.

Updating the workstation after first boot
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Upgrading BIOS
To find and download the latest available BIOS version, which includes the latest enhancements:
1.

Go to http://www.hp.com/go/workstationsupport.

2.

In the Download options tab, select drivers, software & firmware.

3.

Follow the instructions to locate the latest BIOS version available for the workstation.

4.

Compare the BIOS version on your workstation to the BIOS versions on the website (see Determining the
current BIOS version on page 49). If the BIOS version on the website is the same as the version on your
system, no further action is required.

5.

If the BIOS version on the website is a version later than the one on your system, download the
appropriate version for the workstation. Follow the instructions in the release notes to complete the
installation.

Upgrading device drivers
If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm that you
have the latest device drivers loaded. If you purchased your device through HP, go to the HP website to
download the latest drivers for your device. These drivers have been tested to ensure the best compatibility
between your device and your HP workstation.
If you did not purchase your device from HP, HP recommends that you go to the HP website first to see if your
device and its drivers have been tested for HP workstation compatibility. If no driver is available, go to the
device manufacturer's website to download the latest drivers.
To upgrade device drivers:
1.

Go to http://www.hp.com/go/workstationsupport.

2.

In the Download options tab, select drivers, software & firmware.

3.

Follow the instructions to find the latest drivers available for the workstation.

If a required driver is not found, see the website of the manufacturer of the peripheral device.
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Using HP PC Hardware Diagnostics (UEFI)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run diagnostic
tests to determine whether the computer hardware is functioning properly. The tool runs outside the
operating system so that it can isolate hardware failures from issues that are caused by the operating system
or other software components.
When HP PC Hardware Diagnostics (UEFI) detects a failure that requires hardware replacement, a 24-digit
Failure ID code is generated. This ID code can then be provided to support to help determine how to correct
the problem.
NOTE: To start diagnostics on a convertible computer, your computer must be in notebook mode and you
must use the keyboard attached.
To start HP PC Hardware Diagnostics (UEFI), follow these steps:
1.

Turn on or restart the computer, and quickly press esc.

2.

Press f2.
The BIOS searches three places for the diagnostic tools, in the following order:
a.

Connected USB drive
NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading
HP PC Hardware Diagnostics (UEFI) to a USB device on page 51.

3.

b.

Hard drive

c.

BIOS

When the diagnostic tool opens, select the type of diagnostic test you want to run, and then follow the
on-screen instructions.

NOTE:

If you need to stop a diagnostic test, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
NOTE: The HP PC Hardware Diagnostics (UEFI) download instructions are provided in English only, and you
must use a Windows computer to download and create the HP UEFI support environment because only .exe
files are offered.
There are two options to download HP PC Hardware Diagnostics to a USB device.
Download the latest UEFI version
1.

Go to http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2.

In the HP PC Hardware Diagnostics section, select the Download link, and then select Run.

Download any version of UEFI for a specific product
1.

Go to http://www.hp.com/support.

2.

Select Get software and drivers.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
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3.

Enter the product name or number.
– or –
Select Identify now to let HP automatically detect your product.

4.

Select your computer, and then select your operating system.

5.

In the Diagnostic section, follow the on-screen instructions to select and download the UEFI version
you want.

Using Remote HP PC Hardware Diagnostics (UEFI) settings
Your computer supports Remote HP PC Hardware Diagnostics (UEFI). This is a firmware (BIOS) feature that
downloads HP PC Hardware Diagnostics UEFI to your computer.
It executes the diagnostics on your computer, and then uploads results to a preconfigured server.
Using the Remote HP PC Hardware Diagnostics setting in Computer Setup (BIOS), you can perform the
following customizations:
●

Set a schedule for running diagnostics unattended. You can also start diagnostics immediately in
interactive mode.

●

Set the location for downloading the diagnostics tools. This feature provides access to the tools from
the HP website or from a server that has been preconfigured for use. Your computer does not require the
traditional local storage (such as a disk drive or USB flash drive) to run remote diagnostics.

●

Set a location for storing the test results. You can also set the user name and password settings used for
uploads.

●

Display status information about the diagnostics run previously.

Customizing Remote HP PC Hardware Diagnostics (UEFI) settings
1.

Turn on or restart the computer, and when the HP logo appears, press f10 to enter Computer Setup.

2.

Select Advanced, and then select Remote HP PC Hardware Diagnostics.

3.

Make your customization selections.

4.

Select Main, and then Save Changes and Exit to save your settings.

Your changes go into effect when the computer restarts.
To access documentation on using Remote HP PC Hardware Diagnostics (UEFI) to configure a server for
remote diagnostics or to customize which diagnostic test are run, go to http://www.hp.com/support. Select
Find your product, and then follow the on-screen instructions.
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10 Diagnostics and minor troubleshooting
●

Calling support

●

Locating ID labels

●

Locating warranty information

●

HP troubleshooting resources and tools

Calling support
At times you might encounter an issue that requires support. Before you call support, do the following:
●

Have the workstation readily accessible.

●

Write down the workstation serial numbers, product numbers, model names, and model numbers and
have them in front of you.

●

Note any applicable error messages.

●

Note any add-on options.

●

Note the operating system.

●

Note any third-party hardware or software.

●

Note the details of any blinking LEDs on the front of the workstation (tower and desktop configurations)
or on the side of the workstation (all-in-one configurations).

●

Note the applications you were using when you encountered the problem.

NOTE: When calling in for service or support, you might be asked for the product number (example:
PS988AV) of the workstation. If the workstation has a product number, it is generally located next to the 10or 12-digit serial number of the workstation.
NOTE: On most models, the serial number and product number labels can be found on the top or side panel
and at the rear of the workstation (tower and desktop configurations) or on a pull-out card on the side of the
display (all-in-one configurations).
For a listing of all worldwide support phone numbers, go to http://www.hp.com/support, select your region,
and click Connect with HP in the upper-right corner.

Calling support
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Locating ID labels
To assist in troubleshooting, identification labels are available on each workstation.
●

All workstations have a serial number (unique for each workstation) and product number. Have these
numbers available when you contact support.

●

The Certificate of Authentication (COA) is used for Windows 7-preinstalled systems only.

●

The Genuine Microsoft Label (GML) is used for Windows 8-preinstalled systems only.

●

A service label shows the build ID and Feature Byte strings, which are needed for system board
replacement.

NOTE:

Your workstation may look slightly different from the illustration in this section.

Locating warranty information
To locate warranty information, go to http://www.hp.com/support/warranty-lookuptool.
To locate an existing Care Pack, go to http://www.hp.com/go/lookuptool.
To extend a standard product warranty, go to http://www.hp.com/hps/carepack. HP Care Pack Services offer
upgraded service levels to extend and expand a standard product warranty.

HP troubleshooting resources and tools
This section provides information to guide you in troubleshooting your system.

Online support
Online support resources include web-based troubleshooting tools, technical knowledge databases, driver
and patch downloads, online communities, and product change notification services.
The following websites are also available to you:

54

●

http://www.hp.com—Provides useful product information.

●

http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.
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●

http://www.hp.com/go/workstationsupport—Provides technical support information for workstations.

●

http://www8.hp.com/us/en/contact-hp/phone-assist.html—Provides a listing of the worldwide
technical support telephone numbers. Select your region.

●

http://www.hp.com/support/workstation_swdrivers—Provides access to software and drivers for
workstations.

HP Support Center
To help you troubleshoot problems yourself, HP provides the HP Support Center. The HP Support Center is a
portal to an extensive selection of online tools. To access the HP Support Center, complete the following
steps:
1.

Go to http://www.hp.com/go/workstationsupport.

2.

Search for your product.

3.

In the Top issues & solutions tab, under Other solution options, select Troubleshoot a problem.

4.

Select the problem that you are troubleshooting.

HP Chat Support
HP Chat Support is a set of web-based support tools that automate and speed up the resolution of problems
concerning desktop computing, tape storage, and printing.
HP Chat Support enables you to electronically submit a support ticket to HP over the web. When you submit a
support ticket, HP Chat Support collects information about the workstation and passes it to an online support
specialist. The collection of information might take up to 30 seconds, depending on the workstation
configuration. When you submit a support ticket, you receive a confirmation message containing your case ID,
the support hours for your location, and the estimated time of response.
For more information about HP Chat Support, go to http://instantsupport.hp.com/.
NOTE:

This feature is not available for Linux.

Customer Advisories, Customer and Security Bulletins, and Customer Notices
To find advisories, bulletins, and notices:
1.

Go to http://www.hp.com/go/workstationsupport.

2.

Search for your product.

3.

In the Top issues & solutions tab, under Other solution options, select Advisories, bulletins & notices.

4.

Select an item for viewing.

Product Change Notifications
Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a 30- to
60-day window of the effective date of the change in the manufacturing process. PCNs give customers
advance notice of changes to their product, such as an updated BIOS version that they might need to decide
whether to download prior to the change taking place. To view a list of PCNs, go to the Advisories, Bulletins
& Notices page for your product.

HP troubleshooting resources and tools
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Helpful hints
If you encounter a problem with the workstation, monitor, or software, the following general suggestions
might help you isolate and focus on the problem before taking further action.

At startup
●

Verify that the workstation is plugged into a functional AC outlet.

●

Remove all optical discs and USB flash drives before starting the workstation.

●

Verify that the workstation is on and the power light is on.

●

If you have installed an operating system other than the factory-installed operating system, confirm
that it is supported on your system by going to http://www.hp.com/go/quickspecs.

●

Verify that the internal display panel is lit.

●

If the internal display panel is dim, turn up the brightness.

●

If you have an external monitor:
—

Verify that the monitor is plugged into a functional AC outlet.

—

Verify that the monitor is on and the green monitor light is on.

—

If the monitor is dim, turn up the brightness and contrast controls.

During operation
●

Beeps and blinking lights on the workstation are error codes that can help you diagnose problems. For
more information on interpreting these codes, see the Diagnostic LED and audible (beep) codes section
in the Maintenance and Service Guide for your workstation.

●

Press and hold any key. If the system beeps, your keyboard is operating correctly.

●

Check all cables for loose or incorrect connections.

●

Wake the workstation by pressing the power button or any key on the keyboard. If the system remains in
suspend mode, shut down the system by pressing and holding the power button for at least four
seconds. Then press the power button again to restart the system.
If the system does not shut down, unplug the power cord, wait a few seconds, and then plug it in again.
If the system does not restart, press the power button.
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●

After installing a non-PnP expansion board or other option (such as a diskette drive), restart the
workstation.

●

Be sure that all required device drivers have been installed. For example, if you have connected a printer,
you must install a printer driver.

●

If you are working on a network, use another cable to plug your workstation into the network
connection. If you still cannot connect, there might be a problem with the network plug.

●

If you recently added new hardware, remove the hardware to see whether the workstation functions
properly.

●

If you recently installed new software, uninstall the software to see whether the workstation functions
properly.

●

If the internal display panel on an all-in-one workstation is blank, open the workstation and be sure that
both ends of the cable between the system board and the internal display panel are connected. If you
are using a graphics card, verify that the card is properly installed.
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●

Upgrade the BIOS. A new release of the BIOS might have been released that supports new features or
fixes your problem.

●

For more detailed information, see the troubleshooting chapter in the Maintenance and Service Guide at
http://www.hp.com/support/workstation_manuals.

Customer Self Repair
Under the Customer Self Repair programs, you can order a replacement part and install the part without onsite HP technical assistance. Customer Self Repair might be required for some components. For more
information, go to http://www.hp.com/go/selfrepair and select your product.
NOTE: Some components are not eligible for Customer Self Repair and must be returned to HP for service.
Call support for further instructions before attempting to remove or repair these components.

More troubleshooting options
The following additional information about troubleshooting techniques and tools is provided in the
Maintenance and Service Guide at http://www.hp.com/support/workstation_manuals:
●

POST Error Codes.

●

Diagnostic lights and audible (beep) codes.

●

Troubleshooting scenarios and solutions.

●

HP PC Hardware Diagnostics (UEFI) — A set of diagnostic tests that helps determine whether the
hardware is functioning properly.

HP troubleshooting resources and tools

57

11 Routine care
●

General cleaning safety precautions

●

Recommended cleaning products

●

Cleaning the chassis

●

Cleaning the keyboard

●

Cleaning the monitor

●

Cleaning the mouse

General cleaning safety precautions
●

Never use solvents or flammable solutions to clean the workstation.

●

Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth and then
use the cloth on the component.

●

Always unplug the workstation before cleaning the keyboard, mouse, or air vents.

●

Always disconnect the keyboard before cleaning it. If the keyboard has an on/off switch, turn it off
before disconnecting the keyboard.

●

Wear safety glasses equipped with side shields when using compressed air, to prevent dust and debris
from getting into your eyes.

Recommended cleaning products
Use the following products to safely clean your workstation:
●

Dimethyl benzyl ammonium chloride 0.3 percent maximum concentration, usually in the form of
disposable wipes in a variety of brand names

●

Alcohol-free glass cleaning fluid

●

Water with mild soap solution

●

Dry microfiber cleaning cloth or a chamois (static-free cloth without oil)

●

Static-free cloth wipes
CAUTION: Avoid strong cleaning solvents that can permanently damage your workstation. If you are
not sure if a cleaning product is safe for your workstation, check the product contents to be sure that
ingredients such as alcohol, acetone, ammonium chloride, methylene chloride, and hydrocarbons are
not included.

●
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Fibrous materials, such as paper towels, can scratch the workstation. Over time, dirt particles and
cleaning agents can get trapped in the scratches.
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Cleaning the chassis
●

Follow the safety precautions in the Maintenance and Service Guide for your workstation before cleaning
the workstation.

●

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

●

For heavier stains, use a soft microfiber cloth or chamois moistened with mild dish washing liquid
diluted with water. Rinse well by wiping the surface with a cloth or swab dampened with clear water.

●

After cleaning, always wipe the workstation with a clean, lint-free cloth.

●

Occasionally, clean the air vents on the workstation. Lint and other foreign matter can block the vents
and limit the airflow.

Cleaning the keyboard
●

Always disconnect the keyboard before cleaning it. If the keyboard has an on/off switch, turn it off
before disconnecting the keyboard.

●

Follow the safety precautions in the Maintenance and Service Guide for your workstation before cleaning
the keyboard.

●

Visible debris underneath or between the keys can be removed by vacuuming or shaking.

●

Canned, pressurized air can be used to clean debris from under the keys. Use caution because too much
air pressure can dislodge lubricants applied under the wide keys.

●

If you remove a key, use a specially designed key remover to prevent damage to the keys. This tool is
available from many electronics supply outlets.
CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys are
improperly removed or installed, the keyboard might not function properly.

●

Clean under a key with a swab moistened with one of the products mentioned in Recommended cleaning
products on page 58 of this guide. Be careful not to wipe away lubricants necessary for proper key
functions. Allow the parts to air dry before reassembly.

●

Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
●

Follow the safety precautions in the Maintenance and Service Guide for your workstation before cleaning
the monitor.

●

Gently wipe the display using a soft, lint-free cloth moistened with water or an alcohol-free glass
cleaner.
CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the housing
and damage a component.
Never use solvents or flammable liquids on the monitor because display or housing damage may result.

Cleaning the chassis
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Cleaning the mouse
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1.

Follow the safety precautions in the Maintenance and Service Guide for your workstation before cleaning
the mouse.

2.

If the mouse has an on/off switch, turn it off.

3.

Wipe the body of the mouse with a soft microfiber cloth or chamois moistened with alcohol-free glass
cleaning fluid or water with mild soap solution.

4.

Note these guidelines:
●

Laser or light: use a cotton swab dampened with cleaning solution to gently brush out any dust
around the laser or light, and then wipe again with a dry swab. Do not wipe the laser or light
directly with the swab.

●

Scroll wheel: spray canned, pressurized air into the gap between the scroll wheel and the click
buttons. To avoid condensation, do not blow air directly on one spot for an extended period.

●

Roller ball: remove and clean the roller ball, remove any debris from the ball socket, wipe out the
socket with a dry cloth, and reassemble the mouse.
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12 Accessibility
HP designs, produces, and markets products and services that can be used by everyone, including people with
disabilities, either on a stand-alone basis or with appropriate assistive devices.

Supported assistive technologies
HP products support a wide variety of operating system assistive technologies and can be configured to work
with additional assistive technologies. Use the Search feature on your device to locate more information
about assistive features.
NOTE: For additional information about a particular assistive technology product, contact customer support
for that product.

Contacting support
We are constantly refining the accessibility of our products and services and welcome feedback from users. If
you have an issue with a product or would like to tell us about accessibility features that have helped you,
please contact us at (888) 259-5707, Monday through Friday, 6 a.m. to 9 p.m. Mountain Time. If you are deaf
or hard-of-hearing and use TRS/VRS/WebCapTel, contact us if you require technical support or have
accessibility questions by calling (877) 656-7058, Monday through Friday, 6 a.m. to 9 p.m. Mountain Time.

Supported assistive technologies
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